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Advanced Job Scheduler
The IBM® Advanced Job Scheduler for i5/OS® (5761-JS1) licensed program is a powerful scheduler that
allows unattended job processing 24 hours a day, 7 days a week. This scheduling tool provides more
calendar features and offers greater control over scheduled events than the Management Central
scheduler. You can also view job completion history and manage notification of a job's status.
If you want to schedule jobs on several systems in your network, the product must be installed on each
of your systems. If you want to use the Advanced Job Scheduler in System i® Navigator (and in
Management Central), then you must install the client plug-in from a system that has the Advanced Job
Scheduler installed.
However, it is not necessary to install the Advanced Job Scheduler licensed program on each endpoint
system in your Management Central network. When you install the Advanced Job Scheduler on the
central system, jobs or tasks that you define on an endpoint system gather job information that is needed
from the central system. You must set up all job definition information on the central system.
If systems in your network have the Advanced Job Scheduler installed locally, you can schedule tasks
outside of the Management Central network. Under My Connections in System i Navigator, you have
access to the Advanced Job Scheduler on that local system when you expand Work Management.
What's new in Advanced Job Scheduler for V6R1
| Enhancements were made to the IBM Advanced Job Scheduler for i5/OS (5761-JS1) in V6R1. For details
| of the enhancements, see the features page in Job Scheduler for i5/OS
Note: For ordering information, see the Job Scheduler for i5/OS

.
Web site.

Advanced Job Scheduler for Wireless
Advanced Job Scheduler for Wireless is an application that allows you to access Advanced Job Scheduler
on multiple Internet-accessible devices, such as an Internet-ready telephone, PDA Web browser or PC
Web browser.
The wireless feature of Advanced Job Scheduler resides on your system, where Advanced Job Scheduler
is installed, and allows you to access your jobs and activity, as well as send messages to recipients on
your system, and stop and start the Advanced Job Scheduler monitor. Advanced Job Scheduler for
Wireless allows all users to customize the settings and preferences of their own browsing experience. For
instance, a user can show activity, display jobs, and customize the jobs they display.
Advanced Job Scheduler for Wireless allows you to access your jobs when you are normally unable to
access a System i terminal or emulator. Connect to the Internet with your mobile device and enter the
URL for the Advanced Job Scheduler for Wireless servlet. This launches a menu that gives you real-time
access to Advanced Job Scheduler.
Advanced Job Scheduler for Wireless works on two types of devices. A Wireless Markup Language
(WML) device is an Internet-ready cellular phone. A Hypertext Markup Language (HTML) is a PDA or
PC Web browser. Throughout this topic, the different devices are referred to as WML and HTML.

© Copyright IBM Corp. 1998, 2008

1

Scheduling jobs with Advanced Job Scheduler
To manage the Advanced Job Scheduler, you need to install the licensed program first, and then complete
the tasks to customize the Advanced Job Scheduler. Finally, the remainder of the tasks allow you to work
with and manage this scheduler.

Installing the Advanced Job Scheduler
The first time that you connect to your Management Central server, System i Navigator asks if you want
to install the Advanced Job Scheduler. If you chose not to install at that time but want to install later, you
can do so by using the Install Plug-ins feature of System i Navigator.

Procedure
1. From your System i Navigator window, click File from the menu bar.
2. Select Install Options > Install Plug-ins.
3. Click the source system where the Advanced Job Scheduler is installed and click OK. Check with the
system administrator if you are not sure what source system to use.
4. Enter your i5/OS User ID and Password, and click OK.
5. Click Advanced Job Scheduler from the Plug-in selection list.
6. Click Next and then click Next again.
7. Click Finish to complete and exit the setup.

Results
You have now installed the Advanced Job Scheduler.

Locate the scheduler
About this task
To locate the scheduler, follow these steps:

Procedure
1. Expand Management Central.
2. Click Scan Now in response to the message that System i Navigator has detected a new component.
You might see this message again when you access systems from the My Connections container.
3. Expand My Connections, select the system that has the Advanced Job Scheduler licensed program
installed and then select Work Management > Advanced Job Scheduler.

Results
After you have finished this preliminary work with the Advanced Job Scheduler, you are ready to set up
the Advanced Job Scheduler.

Setting up the Advanced Job Scheduler
Before you start scheduling jobs, you need to configure the Advanced Job Scheduler.

Assigning the general properties
You can follow these instructions to assign the general properties used by Advanced Job Scheduler. You
can specify how long to retain activity and log entries for the Advanced Job Scheduler, as well as the
period that jobs are not allowed to run.
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About this task
You can specify the working days that jobs processes, and whether an application is required for each
scheduled job. If you have a notification product installed, you can also set up the command that is used
to send a notification when a job completes or fails or you can use the Send Distribution using Job
Scheduler (SNDDSTJS) command to notify a recipient.
You can specify how long to retain activity records for jobs, as well as the period that jobs are not
allowed to run. You can specify the working days that jobs are allowed to process, and whether an
application is required for each submitted job.
You can have a notification product installed which allows you to receive a notification (message) when a
job ends. You can define the notification command that sends a notification when a job completes or fails.
Or you can use the Send Distribution using Job Scheduler (SNDDSTJS) command to notify a recipient.
To set up the general properties for the Advanced Job Scheduler, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.
3. Specify the Activity Retention. The activity retention is how long you want to retain the activity
records for jobs. The possible values are 1 to 999 days or occurrences. Click Days to specify if you
want to keep activity for a certain number of days, or click Occurrences per job if you want to keep
activity for a certain number of occurrences per job.
4. Specify the Log retention. The log retention specifies, in days, how long you want to retain
Advanced Job Scheduler log entries.
5. You can specify a Reserved period. Jobs do not run during this time.
6. Specify the working days from the list. If a day is selected, it is designated as a working day and can
be referenced when scheduling jobs.
7. Click Application required for scheduled job to designate whether an application is required for
each scheduled job. Applications are jobs that have been grouped together for processing. This
cannot be selected if existing jobs do not contain an application. If you choose to have an application
required for certain jobs, go to working with applications.
8. Click Calendars to set up the scheduling, holiday, and fiscal calendars to use, set up holiday
calendar, and set up fiscal calendar.
9. Click Base periodic frequency on start time to base the next run time on the start time for jobs that
are scheduled to run periodically. For instance, a job is to run every 30 minutes, starting at 8 a.m.
(For a job to run around the clock, specify 7:59 a.m. as the ending time.) The job runs for a total of
20 minutes. With this field checked, the job runs at 8 a.m., 8:30 a.m., 9 a.m., and so on. If this field is
not checked, the job runs at 8 a.m., 8:50 a.m., 9:40 a.m., 10:30 a.m., and so on.
10. Click Reset held jobs to continue to recalculate and display the next date and time a held job runs.
11. Specify a Start time of day. This is the time of day that you consider starts a new day. All jobs that
are specified to use this time of day have their job date changed to the previous day if the time the
job starts is before the Start time of day field.
12. Specify a Job monitor user. This field specifies the name of the user profile to use as the owner of
the monitor job. All jobs that have Current user specified use the user profile of the monitor job. The
monitor job's default user profile is QIJS.
13. In the Notification command field, you can specify a command. Use the Send Distribution using Job
Scheduler Notification (SNDDSTJS) command supplied with the system or a command specified by
your notification software. The SNDDSTJS command uses the Advanced Job Scheduler notification
function. The designated recipients can receive messages for normal and abnormal completions of
job scheduled entries.
Advanced Job Scheduler
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Specifying permission levels
This information explains how to specify permission levels for jobs, functions of the product, and provide
new job default permissions.

About this task
You can specify permission levels for jobs, functions of the product, and provide new job default
permissions to be associated with each Job Control/Application. The permissions for a job allow you to
grant or deny access to the following actions: submit, manage, permission, display, copy, update, or
delete. You can also grant or deny access to individual functions of the product such as Work with
Schedule Calendars, Send Reports, and Add Job.
Default permission levels are transferred to new jobs when they are added. In which case, the system
transfers the New Job permissions based on the application specified within the job definition. If no
application is used, it transfers the *SYSTEM New Job permissions.
Specifying permission levels for functions of the product:
About this task
To specify permission levels for functions of the product, follow these steps:
Procedure
1. From System i Navigator, expand Work Management.
2. Right-click Advanced Job Scheduler and click Properties.
3. Click Permissions.
4. Select a function and click Properties.
5. On the Function Permissions Properties window, edit the permission level as necessary. You can grant
or deny access to the public or specific users.
Specifying permission levels to jobs:
About this task
To specify permission levels to jobs, follow these steps:
Procedure
1. From System i Navigator, expand Work Management.
2. Right-click Advanced Job Scheduler and click Scheduled Jobs to list jobs.
3. Right-click the scheduled job and click Permissions.
4. On the Permissions Properties window, edit the permission level as necessary. You can grant or deny
access to the public or specific users. In addition, you can specify submit, manage, permission,
display, copy, update, or delete permissions.
Specifying default permission levels:
About this task
To specify default permission levels for new jobs associated with a Job Control/Application, follow these
steps:
Procedure
1.
2.
3.
4.

From System i Navigator, expand Work Management.
Right-click Advanced Job Scheduler and click Properties.
Click Job Controls/Applications.
Select a job control or application from the list and click New Job Permissions.
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5. On the Function Permissions Properties window, edit the permission level as necessary. You can grant
or deny access to the public or specific users. In addition, you can specify submit, manage,
permission, display, copy, update, or delete permissions.

Setting up a scheduling calendar
These instructions show how to set up a calendar of selected days for scheduling a job or job group. This
calendar can specify the dates to be used for scheduling a job, or it can be used in conjunction with other
schedules.

About this task
A scheduling calendar is a calendar of selected days that you can use for scheduling a job or job group.
You can display scheduling calendars, add a new scheduling calendar, add a new scheduling calendar
based on an existing one, or remove an existing calendar, provided it is not in use by a currently
scheduled job.
You can select a calendar and display its properties to make changes. When you select a calendar, the
details of the calendar are displayed under Details.
To set up a scheduling calendar, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.
On the General page, click Calendars.
On the Scheduling Calendars page, click New.
Specify a Name.
In the Description field, specify text that describes the calendar.
Choose a Reference calendar if applicable. This is a calendar that was previously set up, and its
properties are applied to the new calendar as if you merged the two calendars. You do not have
reference calendars if this is your first time using the Advanced Job Scheduler.
8. Select the dates that you want to include on your calendar. You must specify whether each date you
have selected is for the current year or for every year in the Selected date field, before you can add
another date to the calendar. Otherwise, any date you select is deselected when you click a different
date.
9. Specify if you want certain days of the week to be included on the calendar.

3.
4.
5.
6.
7.

Setting up a holiday calendar
These instructions show how to set up a calendar for days that you do not want to allow processing for a
scheduled job. Alternate days can be specified for each exception day, or processing can be skipped
completely for that day.

About this task
A holiday calendar is an exception calendar for days that you do not want to process an Advanced Job
Scheduler job. Alternate days can be specified for each exception day that you specify in a holiday
calendar. You can display holiday calendars, add a new holiday calendar, add a new holiday calendar
based on an existing one, or remove an existing calendar, provided it is not in use by a currently
scheduled job.
Predefined schedules can be used in holiday calendars. You can create a schedule THIRDFRI that has a
frequency of the third Friday of each month. When you use THIRDFRI in a holiday calendar, you cause

Advanced Job Scheduler
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all jobs that use this holiday calendar to not run on the third Friday of each month. One or more
schedules can be used in a holiday calendar. Dates that are generated by the schedule are shown on the
calendar with a black border.
You can select a calendar and display its properties to make changes. When you select a calendar, the
details of the calendar are displayed under Details.
Setting up a holiday calendar:
About this task
To set up a holiday calendar, follow these steps:
Procedure
1. Expand Work Management from your System i Navigator window.
Right-click Advanced Job Scheduler and select Properties.
On the General page, click Calendars.
Click the Holiday Calendars tab.
Click New and type a name for the calendar.
In the Description field, specify text to describe the calendar.
Choose a Reference calendar if applicable. This is a calendar that was previously set up, and its
properties are applied to the new calendar as if you merged the two calendars. You do not have
reference calendars if this is your first time using the Advanced Job Scheduler.
8. Select the dates that you want to include on your calendar. You must specify whether each date you
have selected is for the current year or for every year in the Selected date field, before you can add
another date to the calendar. Otherwise, any date you select is deselected when you click a different
date.
2.
3.
4.
5.
6.
7.

9. Select an alternate day for the job to run. You can choose the previous working day, next working
day, a specific date or not at all. To select a specific date, click Specific alternate date, and type the
date.
10. Select specific days of the week to be included on the calendar.
Adding a schedule to a holiday calendar:
About this task
To add a holiday calendar to a scheduled job, follow these steps:
Procedure
1. Expand Work Management from your System i Navigator window.
2.
3.
4.
5.
6.
7.

Right-click Advanced Job Scheduler and click Properties.
On the General page, click Calendars.
On the Holiday calendar page, select the holiday calendar and click Properties.
From the lower left hand corner of the tab, click Schedules.
Select the appropriate schedule and click Add.
To change the Alternate day, right-click the schedule from the Selected Schedules list and click the
correct Alternate Day.

Setting up a fiscal calendar
If you want to divide the fiscal year into periods other than months, follow these steps to set up a fiscal
calendar of selected days for scheduling a job or job group.
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About this task
A fiscal calendar is a calendar of selected days that you can use for scheduling a job or job group. Use a
fiscal calendar to define a fiscal calendar that is unique to your business. You can specify the start and
end dates for each period in the fiscal year.
To set up a fiscal calendar, follow these steps:

Procedure
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Expand Work Management from your System i Navigator window.
Right-click Advanced Job Scheduler and click Properties.
On the General window, click Calendars.
On the Fiscal Calendars page, click New.
Specify a Name.
In the Description field, type in text to describe the calendar.
Click New on the Fiscal Calendar Properties window to create a new entry.
Select a period and specify the start and end dates. You can specify up to 13 periods.
Click OK to save the fiscal calendar entry.
Repeat steps 7 through 9 as necessary.

Specifying a mail server to use for notification
A mail server is required if you want to send e-mail notification messages.

About this task
To set up the notification properties, follow these steps:

Procedure
1.
2.
3.
4.

Expand Work Management from your System i Navigator window.
Expand Advanced Job Scheduler.
Right-click Notification and click Properties.
Specify how many days to store messages. Specify a number in the Message retention field.

5. Specify an Outgoing mail server (SMTP). For example, SMTP.yourserver.com.
6. Specify a Port. The default port number is 25.
7.
8.
9.
10.

Specify an e-mail address in the Reply address field. All reply messages are sent to this address.
Select Yes or No in the Log send activity field. Send activity is used for problem determination.
Specify the Number of banner pages allowed. This is used in Report Distribution.
Click OK to save the notification properties.

Setting up multiple scheduling environments
You can set up scheduling environments on the same system. By doing this, the original data library can
act as the active data library and the copied data library can be used for testing. Thus you have two
scheduling environments, one for testing and one that is the actual. In addition, the test data library can
serve as a backup if there is a system failure on the original system. This feature gives you added
protection if you create an error in the original data library because you have a backup copy of the data
library.

About this task
There are several reasons why you might want to set up multiple scheduling environments. You might
want to have a production version and a test version of the product running at the same time. This type
Advanced Job Scheduler
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of environment allows you to test various job schedules before actually using them in the data library on
the production system. Or you might have a system that is the backup for one or more other systems in
which you can use a data-mirroring product to replicate the Advanced Job Scheduler data library
(QUSRIJS) from the source system into a library named differently. In this case, the data library is active
until there is a problem with the source system.
A scheduling environment is a duplicate of the QUSRIJS library except with different data. For instance
you can have another data library named QUSRIJSTST with all the objects as QUSRIJS. Each are
considered data libraries.
To set up a multiple scheduling environment, follow these steps:

Procedure
1. Obtain a data library from a system
To create a data library, you need to obtain a data library from a system. The following are three ways
that you can obtain a data library from the system:
v Save the data library from a system and restore it onto the production system.
v Duplicate the data library on the current system using the Copy Library (CPYLIB) command.
v Mirror a data library on the test system. These systems should be running the same version release
level.
Note: The copied, restored, or mirrored data library uses a different name than the original system.
2. Assign data libraries to users
After you obtain a test data library, add the data library to the Advanced Job Scheduler's properties
and assign users to the data library. Therefore, when a user uses the Advanced Job Scheduler, the
changes that the user makes are stored in the data library assigned to the user.
3. Copy jobs from test data library to actual data library (optional)
If you are using a data library for testing purposes, you might want to copy the jobs from the test
data library to the actual data library in use. You only need to do this if you restored or copied a data
library in step 1 and you have jobs that you want to move to the actual data library in use. You do
not need to do this if you mirrored a data library from the actual system to a test system.
To copy jobs from one system's data library to another, use the Copy Job using Job Scheduler
(CPYJOBJS) command. For more information about the specific parameters for this command, see the
online help.

Assigning data libraries to users
The data library stores any changes that the user does using the Advanced Job Scheduler. A data library
contains all the objects found in the QUSRIJS library. You can have an unlimited number of data libraries.

About this task
To assign data libraries to users, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.
3. On the Data Libraries window, click Add to specify a data library. The data libraries that are listed are
available to all users on the system.
4. On the Users window, click Add to add new users.
5. Specify a name.
6. Select a data library.
7. Click OK to add the user.
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8. Click Properties to change the data library assigned to a user.

Results
With data libraries, you can set up multiple scheduling environments.

Managing the Advanced Job Scheduler
This information shows how to schedule jobs using the Advanced Job Scheduler.

Creating and scheduling a job
You can schedule a job and specify the commands that are associated with the job. You can also specify
starting and ending commands to run a special version of a scheduled job.

About this task
To create and schedule a new scheduled job, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler.
3. Right-click Scheduled Jobs and click New Scheduled Job.

Creating and scheduling a job group
You can set up and schedule a series of jobs that run consecutively in a specified order. Jobs within a job
group require completion before the next job is submitted for processing.

About this task
Job groups are jobs that are grouped together to run consecutively in the order specified. A normal
completion is required for each job in the group before the next job in the group is submitted for
processing. If any job in the group does not complete normally, the processing stops for that group.
To create and schedule a new job group, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Click Advanced Job Scheduler.
3. Right-click Job Groups and click New Job Group.

Results
Refer to the online help for more information as you fill in details for the new job group.

Predefined schedules
You can create schedules that contain information needed to schedule a job or calculate exception dates
within a holiday calendar.

About this task
For instance, you can create an ENDOFWEEK schedule that contains the day of the week to run, along
with any additional calendars. The ENDOFWEEK schedule can then be used by all the jobs that match
that scheduling frequency. You can access this feature only through System i Navigator.

Advanced Job Scheduler
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You can use those same predefined schedules that are used in a job with your holiday calendars. You can
create a schedule THIRDFRI that has a frequency of the third Friday of each month. When you use
THIRDFRI in a holiday calendar, you cause all jobs that use this holiday calendar to not run on the third
Friday of each month. You can use one or more schedules in a holiday calendar. Dates that are generated
by the schedule is shown on the calendar with a black border.
Setting up a predefined schedule:
To set up a predefined schedule, follow these steps.
Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.
3. Click the Schedules tab.
4. Click New and type a name for the schedule.
5. Type a description for the schedule.
6. Select the frequency and dates that you want to include in your schedule, as well as any additional
calendars.
Results
Refer to the online help for more information as you fill in details for the new schedule.
Adding a schedule to a scheduled job:
To add a schedule to a scheduled job, follow these steps:
Procedure
1.
2.
3.
4.

Expand Work Management from your System i Navigator window.
Right-click Advanced Job Scheduler.
Click Scheduled Jobs to list jobs.
Right-click the scheduled job and click Properties.

5. Click the Schedule tab.
6. From the upper right hand corner of the tab, select the appropriate Schedule option.
Adding a schedule to a holiday calendar:
A holiday calendar is an exception calendar for days that you do not want to process an Advanced Job
Scheduler job. Alternate days can be specified for each exception day that you specify in a holiday
calendar.
About this task
To add a schedule to a holiday calendar, follow these steps:
Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.
3. On the General page, click Holiday Calendars.
4. On the Holiday Calendars page, select the holiday calendar and click Properties.
5. From the lower left hand corner of the tab, click Schedules.
6. Select the appropriate schedule and click Add.
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7. To change the Alternate day, right-click the schedule from the Selected Schedules list and click the
correct Alternate Day.
Results
Refer to the online help for more information.

Creating a temporary scheduled job
At times it might be necessary to run a scheduled job now or in the future in addition to its normal
schedule. Use the Submit Job using Job Scheduler (SBMJOBJS) command, option 7 from Work with Jobs
display, or the Run option from System i Navigator. It might also be necessary to process only a portion
of the commands in the command list when setting up this special run.

About this task
The SBMJOBJS command allows you to specify the Starting and Ending command sequences. For
instance, JOBA has 5 commands, sequences 10 through 50. You can specify on the SBMJOBJS command to
start with sequence 20 and end with sequence 40. This bypasses sequence 10 and 50.
System i Navigator allows you to select a starting command within the command list and an ending
command.
To run a special version of a scheduled job with System i Navigator, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler.
3. Click Scheduled Jobs to list jobs.
4. Right-click the scheduled job and click Run.
5. Specify whether to run the job now or in the future.
6. Select the starting and ending commands.

Results
Refer to the online help for more information as you fill in details for the new job.

Scheduling job dependencies
The Advanced Job Scheduler allows you to set up dependencies that reflect how jobs are processed in
your environment. Dependencies determine when a job or group of jobs can run. You can select to have
all dependencies met before a job can run, or you can have at least one dependency met before the job
can run.

About this task
Dependencies include the following:
v Job dependencies
Job dependencies refer to predecessor and successor relationships for jobs. Predecessor jobs are those
that must run before the successor job runs. A successor job is a job that runs after all the predecessor
jobs have been processed. There can be multiple successor jobs for a single predecessor job as well as
multiple predecessor jobs for a single successor job. In addition, you can specify that a dependent job
be skipped if its predecessors and successors run on a day that the dependent job is not scheduled to
run.
v

Active dependencies

Advanced Job Scheduler
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Active dependencies are lists of jobs that cannot be active when the selected job is to be submitted. If
any of the jobs are active, the Advanced Job Scheduler does not let the specified job run. The selected
job is delayed until all the jobs in the list are inactive.
v

Resource dependencies
Resource dependencies are based on several things. Each type that follows describes the areas that are
checked. Following are the types of resource dependencies:
File

The job is dependent on the existence or non-existence of a file and whether it meets the
specified allocation level to be processed. It can also check whether records are present before
the job is processed. For instance, JOBA can be set up so that it only runs when file ABC exists,
and the file can be allocated exclusively and if records are present in the file.

Object
The job is dependent on the existence or non-existence of a QSYS type object and whether it
meets the specified allocation level to be processed. For instance, JOBA can be set up so that it
only runs when data area XYZ exists. The job can also be dependent on the existence or
non-existence of an object found in the integrated file system. If the dependency is based on
any object in the path, end the integrated file system path with a forward slash '/'.
Hardware configuration
The job is dependent on the existence or non-existence of a hardware configuration and its
status to be processed. For instance, JOBA can be set up so that it only runs when device
TAP01 exists and has a status of Available.
Network file
The job is dependent on the status of a network file in order to be processed.
Subsystem
The job is dependent on the status of a subsystem in order to be processed.
To work with job dependencies, follow these steps:

Procedure
1.
2.
3.
4.
5.

Expand Work Management from your System i Navigator window.
Expand Advanced Job Scheduler.
Click Scheduled Jobs.
Right-click the Job Name whose dependencies you want to work with.
Select one of the following: Job Dependencies, Active Dependencies or Resource Dependencies.
Refer to the online help for more information.

The Work Flow Manager
The Work Flow Manager allows you define units of work that consist of automated or manual steps.
These units of work can then be scheduled or run interactively. The Work Flow Manager is located in the
Advanced Job Scheduler container in the System i Navigator interface.
Each step within the work flow can have one or more predecessor Advanced Job Scheduler jobs and one
or more successor Advanced Job Scheduler jobs. When a work flow starts, the first step is flagged to run.
When it completes, the next step is flagged to run, and so on.
The following are some additional considerations when using the Work Flow Manager:
v You can manually start a work flow at any step. When you do so, you bypass all previous steps in the
work flow.
v Automatic steps complete after all prior steps have completed. This includes all predecessor Advanced
Job Scheduler jobs.
v After a step completes, the successor Advanced Job Scheduler jobs are flagged to run.
v Manual steps can complete in any sequence as long as the step's predecessor jobs have finished.
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v You can mark completed manual steps as not complete and run them again as long as there are no
subsequent incomplete automatic steps.
v You can cause a step to wait until the job completes before notifying of the step's completion by
specifying predecessor jobs that are the same as the successor jobs of the previous step.
v You can notify other users when a particular step starts, stops, did not start by a specific time, or is
taking too long. For example you can notify a user who is responsible for a particular manual step that
the previous automated steps have completed.
When you use work flows, the activity log displays when the work flow started, the steps that were run,
the status of automated steps (success or fail), when the work flow ended, and the final status of the
work flow.
Table 1. Work Flow Example
Work Flow

PAYROLL

Scheduled

Every Friday at 1 p.m.

Notification

Clerk - Payroll work flow has started

Step 1

Automatic - Specifies a successor job to initialize payroll files

Step 2

Automatic:
v Specifies the successor job from step 1 as a predecessor job for this step
v Notifies Clerk that timecards can be entered

Step 3

Manual:
v Clerk completes after timecards are entered
v Specifies a successor job to process timecard files and print timecard report
v Notifies Supervisor if step is not completed within 120 minutes

Step 4

Automatic:
v Specifies successor job from previous step as a predecessor job
v No Successor jobs
v Notifies Clerk to check timecard report

Step 5

Manual:
v

Clerk completes after checking reports

v Specifies a successor job to process payroll
Step 6

Automatic:
v

Specifies the successor job from previous step as a predecessor job

v No Successor jobs
v Notifies Clerk and Supervisor that payroll has completed

In this example the work flow PAYROLL starts every Friday at 1:00 p.m. A notification is sent to the
Clerk that the work flow has started.
Because Step 1 is automatic and does not have any predecessor jobs, it flags the successor job that
initializes the payroll files to run and then complete. Step 2 has the successor job for Step 1 as its
predecessor. Step 2 waits for the job that initializes the payroll files to complete. After it has completed,
Step 2 notifies the Clerk that he can enter timecards. There are no successor jobs to flag to run.
The Clerk manually completes Step 3 after all of the timecards are entered. The successor job that
processes the timecard file and prints a timecard report is flagged to run. As a precaution, the Supervisor
is notified if the step is not completed within 120 minutes. Because the predecessor job for Step 4 is the
successor for Step 3, Step 4 waits until the job that processes the timecard file and prints a timecard
report has completed.
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After the job completes the Clerk is notified that the timecard report can be checked. There are no
successor jobs to flag to run. After the timecard report is checked, the Clerk manually completes Step 5.
The successor job that processes the payroll and produces the checks is flagged to run.
Because the predecessor job for Step 6 is the successor for Step 5, Step 6 waits until the job that processes
the payroll and produces the checks has completed. After the job completes, it notifies the Clerk and
Supervisor that Payroll has completed. The checks can now be printed and distributed.
For more detailed information about the Work Flow Manager, see the online help.
Creating a new work flow:
When you create a new work flow, you need to specify how the work flow is started, its maximum
process time, the task steps and their run sequence, scheduling, notification and documentation details.
About this task
To create a new work flow, you must complete the following steps:
Procedure
1. From System i Navigator, expand My Connections > your system > Work Management > Advanced
Job Scheduler.
2. Right-click Work Flow Manager and select New Work Flow. The New Work Flow window is
displayed.
What to do next
For more information about how to complete the New Work Flow window, see the online help.
Once you have set up your work flow, you can manage the work flow by right-clicking the work flow
name and clicking Work Flow Status.
Starting a work flow:
When you start a work flow, you can choose whether you want the work flow to start on the first
sequence or on a specific sequence.
About this task
To start a work flow, do the following steps:
Procedure
1. From System i Navigator, expand Work Management > Advanced Job Scheduler > Work Flow
Manager, right-click a work flow, and select Start. The Start Work Flow window is displayed.
2. Select if you want the work flow to start on the first sequence or on a specific sequence. If you select
to start at a sequence other than the first, all of the prior steps are marked as completed.
What to do next
For more information about the Start Work Flow window, see the online help.
Working with work flows:
You can control and monitor the work flow as it runs by using the Work Flow Status window.
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Before you begin
You can access the Work Flow Status window by expanding My Connections > your system > Work
Management > Advanced Job Scheduler > Work Flow Manager. Right-click a work flow and select
Status.
About this task
v The General window shows you the current status of the work flow.
v The Steps window provides you with a list of all steps currently defined to the work flow.
You can see whether a step has been defined to be either automated or manual and when the step has
started and ended.
– To mark a manual step as complete, select the correct step and check the Complete box.
– Manual steps can be marked completed in any order if all of the predecessor Advanced Job
Scheduler jobs for the step have completed.
– Manual steps can be marked as not completed if there are no Automatic steps completed further in
the list.
– A work flow can be started manually at any step. This bypasses all previous steps.
To refresh the list, click Refresh.
v The Documentation window shows you the documentation text for the work flow.

Monitoring job activity for the Advanced Job Scheduler
You can use the Advanced Job Scheduler to view the history or status of a job or a job group. You can
also set up the activity retention, which is how long you want to retain the activity records for a job.
Scheduled job activity:
The scheduled job activity allows you to specify how long the Advanced Job Scheduler activity records
are to be retained. The possible values are 1 to 999 days or occurrences. You can specify to keep activity
for a certain number of days, or for a certain number of occurrences per job.
The following details about a scheduled job are displayed:
v Name The name of the scheduled job.
v
v
v
v
v

Group The name of the job group for the job.
Sequence The sequence number of the job within the group, if the job is in a job group.
Completion Status The status of the job.
Started When the job started running.
Ended When the job ended.

v Elapsed Time The amount of time in hours and minutes the job took to process.
Specifying the activity retention:
These steps show how to specify the activity retention.
Procedure
1. Expand Work Management from your System i Navigator window.
2. Expand Advanced Job Scheduler.
3. Right-click Scheduled Job Activity and click Properties.
Viewing the scheduled job activity details:
These steps show how to view the scheduled job activity details.
Advanced Job Scheduler
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Procedure
1. Expand Work Management from your System i Navigator window.
2. Expand Advanced Job Scheduler.
3. Double-click Scheduled Job Activity.
Viewing the scheduled job activity for a specific job:
These steps show how to view the scheduled job activity for a specific job.
Procedure
1.
2.
3.
4.

Expand Work Management from your System i Navigator window.
Expand Advanced Job Scheduler.
Click Scheduled jobs.
Right-click the Job Name whose activity you want to display and click Activity.

Viewing the activity log details:
The activity log displays activity within the scheduler such as a job added, changed, or submitted.
Security violations, sequences processed by a scheduled job, and any errors received are displayed. The
dates and times for the previous activities are also displayed.
About this task
To view detailed message information, double-click a date and time. To view the activity log details,
follow these steps:
Procedure
1. Expand Work Management from your System i Navigator window.
2. Expand Advanced Job Scheduler.
3. Click Activity Log. The current day's entries are shown. To change the selection criteria, select
Include from the Options menu.
Viewing the activity log for a specific job:
These steps show how to view the activity log for a specific job.
Procedure
1. Expand Work Management from your System i Navigator window.
2. Expand Advanced Job Scheduler.
3. Click Scheduled jobs.
4. Right-click the Job Name whose activity log you want to display and click Activity log.
Results
You can also use the Last Run page of a job's properties to view the progress of a job. Specify the Set
Step using Job Scheduler (SETSTPJS) command before or after a step in the CL program along with a
description that states the progress of the job. When the job reaches the SETSTPJS command in the
program, the associated description is displayed in the Last Run page and on your wireless device.

Monitoring for messages with Advanced Job Scheduler
Each command in the command list of a job can have message identifiers that are used for monitoring.
When the job runs and an error message is issued that matches one of the messages entered for the
selected command, the job logs the error but continues processing with the next command in the list.
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About this task
If zeros are specified in either two or all four of the rightmost positions, such as ppmm00, a generic
message identifier is specified. For example, if CPF0000 is specified, all the CPF messages are monitored.
To add message identifiers to a command, follow these steps:

Procedure
1.
2.
3.
4.

Expand Work Management from your System i Navigator window.
Right-click Advanced Job Scheduler.
Click Scheduled Jobs to list jobs.
Right-click the scheduled job and click Properties.

5. Select the command from the list and click Properties.
6. Click Messages.
7. Enter the message identifiers to monitor and click Add.

Creating and working with local data area
A local data area is a portion of space that is allocated for a job. Not all jobs use their local data area but
some do. Each command within a job has access to the job's local data area. You might want to use a
local data area if you are scheduling a job that previously required you to manually specify additional
parameters. Use the local data area to specify the additional parameters so you do not need to manually
specify them each time the job starts.

About this task
To specify local data area information for a scheduled job, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Expand Advanced Job Scheduler > Scheduled Jobs.
3. Right-click a job and click Properties.
4. Edit the Local Data Area window as necessary.

Results
Refer to the online help for more information as you fill in details for the local data area.

Creating and working with application controls and job controls
Applications are jobs that are grouped for processing. They are broader than job groups and do not
necessarily process sequentially. Jobs in applications can process simultaneously and one job does not
need to wait for another to process. All jobs within the application can be worked with and can have
their own set of job defaults. Job controls are the defaults assigned to a job as you add it to the job
scheduler as well as defaults used when the job is submitted.

About this task
Applications are jobs that have been grouped together for processing. For example, you might have a
series of jobs that you use for payroll that you want to group together for an accounting process.
Job Controls are the defaults assigned to a job as you add it to the job scheduler as well as defaults used
when the job is submitted. Job control defaults include such things as calendar, holiday calendar, job
queue, job description and so on.

Advanced Job Scheduler
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You can display all the existing applications or job controls on your system. You can add a new
application control or a job control, add a new application controls or job controls based on an existing
one, or remove an application control or a job control. You can also select an application or job control
and display its properties to make changes.
To create a new application/job control, follow these steps:

Procedure
1.
2.
3.
4.

Expand Work Management from your System i Navigator window.
Right-click Advanced Job Scheduler and click Properties.
Click the Applications/Job Controls tab.
Click New and type a name for the application.

5. Type a description for the application.
6. Choose the contacts for the application. Contacts are the names of users who are contacted if you
have a problem with a job within the application. You can specify up to 5 contacts per application.
You can also choose to add or remove contacts from the contact list.
7. You can type additional information to help you identify the application. The information is
associated with the new application. This information might be useful if any problems occur.

Working with notification
Within notification, you can perform a series of tasks. Notification allows you to specify recipient
properties and report distribution list properties. In addition, you can send e-mail messages and set up
an escalation list in case a recipient does not respond within a specified amount of time.

About this task
Before you can send an e-mail message, you need to specify a mail server to use for notification.
The following are highlights of the notification function of Advanced Job Scheduler:
Recipient
When scheduling a job, you can specify whether to send notification messages to specified
recipients. You can send a notification message if a job fails, completes successfully, or does not
start within a specified time limit. For each specified recipient, you need to define the recipient's
properties. You can access the recipient's properties by selecting Advanced Job Scheduler >
Notification > Recipients, and then select a recipient from the list of recipients.
Report distribution list
Use a report distribution list to specify a list of spooled files that are eligible for distribution. Each
spooled file produced by a job is checked to see if a match exists within the spooled file list. If so,
the recipients associated with that spooled file receives a copy of the spooled file via e-mail, a
duplicate of the spooled file in their output queue, or both. You can access report distribution
lists by selecting Advanced Job Scheduler > Notification > Report distribution list.
E-mail You can send an e-mail message to any recipient that is defined in the list of recipients as well as
specific e-mail addresses. The recipient's properties must specify an e-mail address to send the
message to. When sending an e-mail message, you can attach a spooled file. The spooled file can
be sent in PDF format. In addition, you can specify an escalation list to use if the intended
recipient does not respond within a specified period of time.
Specifying a spooled file to attach to an e-mail:
About this task
To specify a spooled file to attach to an e-mail, complete the following:
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Procedure
1. Expand Basic Operations from your System i Navigator window.
2. Click Printer Output.
3. Right-click the spooled file and click Send via AJS.
4. Specify a recipient, subject, and message.
Results
Note: This also can be done from Output Queues.
Escalation list
An escalation list specifies a list of recipients in descending order. The recipients are notified in
the order that they are listed. If the first recipient does not respond to the message, the message
is sent to the next recipient. This process continues until a response is made. To define an
escalation list, go to Advanced Job Scheduler > Notification > Escalation Lists.
Stopping a message from escalating:
About this task
To stop a message from escalating, complete the following:
Procedure
1. Expand Work Management from your System i Navigator window.
2. Click Advanced Job Scheduler > Notification > E-mail > Sent.
3. Right-click the escalating message and click Stop.
Note: To view only escalating messages, select View > Customize this view > Include from the
System i Navigator window. Then, in the Type field, select Escalating.

Working with library lists
Library lists are user-defined lists of libraries that are used by the Advanced Job Scheduler when a job is
processing.

About this task
A library list is a user-defined list of libraries that is used by the Advanced Job Scheduler job to search
for information it needs while processing. You can display library lists, add a new library list, add a new
library list based on an existing one, or remove a library list, provided that it is not being used by a
currently scheduled job.
You can select a list and display its properties to make changes. You can place up to 250 libraries on the
library list.
To add a new library list, follow these steps:

Procedure
1.
2.
3.
4.
5.
6.

Expand Work Management from your System i Navigator window.
Right-click Advanced Job Scheduler and click Properties.
Click the Library Lists tab.
Click New and type a name for the library list.
Type a description for the library list.
Click Browse to see a list of existing libraries, and click a library.

7. Click Add to add the list of selected libraries.
Advanced Job Scheduler
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Results

Working with command variables
A command variable (previously known as a parameter) is a variable you can store and use in jobs
submitted through the Advanced Job Scheduler. Examples of command variables include the beginning of
each month, a division number, a company number, and so on.

About this task
Command variables (previously known as parameters) are variables that you store in the Advanced Job
Scheduler and use in jobs submitted through the Advanced Job Scheduler. Command variables contain
information that is replaced inside the command string of a scheduled job. Examples of command
variables include the beginning of each month, a company division number, a company number and so
on. You can display command variables, add a new command variable, add a new command variable
based on an existing one, or remove a command variable, provided it is not currently in use by a
scheduled job.
You can select an existing command variable and display its properties to make changes.
To add a new command variable, follow these steps:

Procedure
1. Expand Work Management from your System i Navigator window.
2. Right-click Advanced Job Scheduler and click Properties.
3.
4.
5.
6.
7.

Click the Command Variables tab.
Click New and type a name for the command variable.
Type a description for the command variable.
Type the length of the command variable. The length can range from 1 to 90.
Choose how you want to supply the replacement value:
a. Specify the data to use for the command variable. You use any character in this field. The number
of characters in the data cannot be greater than the length specified in the Length field.
b. Type a formula to calculate the date. (For examples, see the online Help.)
c. Type the program name that you use to retrieve the replacement value.
d. Type the library that you use to retrieve the replacement value.
e. Choose whether you want the replacement value retrieved from the system operator at run time.

Working with Advanced Job Scheduler for Wireless
Advanced Job Scheduler for Wireless works on two types of devices. A Wireless Markup Language
(WML) device is an Internet-ready cellular phone. A Hypertext Markup Language (HTML) is a PDA or
PC Web browser. Throughout this topic, the different devices are referred to as WML and HTML.

Hardware and software requirements
Before yon run Advanced Job Scheduler for Wireless, make sure that you have met all the necessary
software and hardware requirements.
The following elements are required to run the Advanced Job Scheduler for Wireless:
v The Advanced Job Scheduler (5761-JS1) licensed program : The Advanced Job Scheduler product that
includes Advanced Job Scheduler for Wireless.
v A device to run the function
– An Internet-enabled telephone with a wireless internet service
– A PDA with a Web browser, a wireless modem, and a wireless internet service
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– A traditional Web browser on a workstation
v A system running i5/OS V5R3 or later in a TCP/IP network.
v A Web application server running on your central system, such as any of the following:
– ASF Jakarta Tomcat Application server
– Any other application server that runs on the central system, having the capability to host servlets
v HTTP Server installed on the system
v Identify your HTTP server with the Advanced Job Scheduler wireless feature. To do this, connect to the
system that has Advanced Job Scheduler installed by using the character-based interface. Then, specify
the following command:
CALL QIJS/QIJSCINT

Selecting a device
Internet-ready telephones and wireless PDAs are a rapidly changing technology. They differ in screen
size, in user interface, and in many other significant characteristics. The information in this topic helps
you choose devices that are compatible with Advanced Job Scheduler for Wireless. Other wireless devices
are also compatible if they support wireless Internet browsing, but the interaction might be different.
Internet-ready telephones: Select an Internet-ready telephone to use with Advanced Job Scheduler for
Wireless.
PDAs: Select a PDA to use with Advanced Job Scheduler for Wireless.
PCs: You can also use a traditional Web browser with Advanced Job Scheduler for Wireless.

Configuring your wireless environment
To ensure that the Advanced Job Scheduler for Wireless run properly, you need to modify your web
application server and firewall configuration.

About this task
Before you begin using Advanced Job Scheduler for Wireless, ensure that you have properly configured
or set up the following items:

Procedure
1. Configure your Web application server: Set up Advanced Job Scheduler for Wireless to run using an
ASF Jakarta Tomcat servlet engine. These instructions specify how to create and start your Web
application server. In addition, it specifies a program that you need to run before working with the
wireless function of Advanced Job Server.
2. Configure your firewall: When you use System i Navigator for Wireless, you access your system from
the Internet. If you have a firewall, you might have to modify your firewall setup to run System i
Navigator for Wireless.
3. Select a language: The default language is set to English, but you can configure your device to display
your language of choice.

Results
After you have completed these steps, you are ready to connect to your server and begin using Advanced
Job Scheduler for Wireless.
Configuring your Web application server:

Advanced Job Scheduler
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Before working with Advanced Job Scheduler for Wireless, you must start and configure the Web
application server. The following procedures set up an ASF Tomcat servlet engine for HTTP Server
(powered by Apache) to run Advanced Job Scheduler for Wireless.
Requirements
Before you begin, you must have QSECOFR authority and the IBM HTTP Server for i5/OS (5761-DG1)
licensed program installed:
Note: The following instructions create a new instance of an HTTP Server; you cannot use the following
instructions to set up Advanced Job Scheduler on an existing HTTP Server.
Initializing Advanced Job Scheduler for Wireless on the HTTP Server
Running the following command adds the Advanced Job Scheduler for Wireless servlet to the Apache
Software Foundation Jakarta Tomcat servlet engine. It also sets up an IBM HTTP Server (powered by
Apache) named Advanced Job SchedulerP that listens for requests on port 8210.
Before working with Advanced Job Scheduler for Wireless, you need to initialize the Advanced Job
Scheduler for Wireless on the HTTP server instance on your system. To do this, specify the following
command from the character-based interface.
CALL QIJS/QIJSCINT
This command runs a program that is supplied with your system.
After you configure your Web application server and initialize the Advanced Job Scheduler instance on
the Web application server, you can continue configuring your Advanced Job Scheduler wireless
environment.
Selecting a language:
When you connect to Advanced Job Scheduler for wireless, you can specify which language to use. If you
do not want to specify a specific language, you can proceed to connecting to your system.
To specify a language, use the following URL:
host. domain: port/servlet/AJSPervasive?lng= lang
v host: The host name of the system that contains the product.
v domain: The domain where the host is located.
v port: The port that the instance of the Web server is listening to
v lang: The 2-character identifier for the language. The following is a list of available languages and their
2-character identifiers. (ar: Arabic de: German en: English es: Spanish fr: French it: Italian ja: Japanese)
Now you can begin working with Advanced Job Scheduler for Wireless.

Connecting to your i5/OS operating system
You can use your wireless device to connect to the system that contains the Advanced Job Scheduler
product.
To begin using Advanced Job Scheduler for Wireless, specify the URL of your system into your wireless
device. When pointing your device to the URL on your system, use the following format. Ensure that the
end of the URL (after http://host.domain:port/) is typed exactly as shown:
v On V5R4, use: http://host.domain:port/servlet/AJSPervasive
v On 6.1 and later, use: http://host.domain:port/AJSPervasive/AJSPervasive
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Replace host, domain, and port with:
v host: The System i host name.
v domain: The domain where the system is located.
v port: The port that the instance of the Web server is listening to. Default is 8210.
Note: The host.domain portion of the URL can be replaced with an external IP address.
Internet-ready telephone and PDA browser layout
If you have successfully connected to the Advanced Job Scheduler for Wireless feature on your system,
the initial display contains summary information about your Internet-ready telephone or PDA. The
summary specifies how current the information is, how many scheduled jobs exist, how many activity
entries exist, and options to check the status of the job monitor or send a message to a recipient. In
addition, the summary provides an overall status of OK or Attention at the top of the display. If
Attention is specified, a job has a message that needs more attention. The job that requires attention
contains an exclamation point.
Traditional browser layout
The traditional browser layout is exactly the same as the Internet-ready telephone and PDA display.
However, the amount of content is smaller than the size of the display. Therefore, you can reduce the size
of the Web browser to allow for more space to work with other applications while keeping the Advanced
Job Scheduler for Wireless Web browser open. In addition, if you are using a traditional Internet browser
on your PC, you can select to Show all from the Advanced Job Scheduler main menu. Then, you can
view more content in a single Web page.
After you have successfully connected to your system, you might want to customize your connection.

Customizing your connection
Using your wireless device, you can customize the interface to your specific needs. For example, you
might want to view only certain jobs and specify not to view the job's group name. You also might not
want to access the list of scheduled activity. The Customize page on your wireless device allows you to
filter jobs as well as change display preferences.
There are many ways to customize your connection whether you are using a PC, PDA, or Internet-ready
telephone. To take advantage of these features, see the Job Scheduler for i5/OS

Web site.

Managing Advanced Job Scheduler for Wireless
You can use your wireless device to work with Advanced Job Scheduler.
The following features are available using a wireless device:
View active, held, and pending jobs
You can view a list of the regular jobs (Advanced Job Scheduler jobs) or Management Central
jobs that have the active, held, or pending state. You can further customize the jobs displayed by
sorting by job type, name, or time. In addition, you can specify which data library contains the
data for jobs and activities.
View job dependencies
You can view the predecessor and successor jobs for a particular job. A successor is a job that is
dependent on one or more jobs (predecessors) to run. In turn, a successor job can be a
predecessor job to other successor jobs.
Display messages
If a job has a message waiting for it, you can view the message text and reply to the message
using your wireless device.
Advanced Job Scheduler
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Start jobs
You can use your wireless device to submit jobs. The options you can specify when submitting a
job depend on what wireless device you use.
Work with Advanced Job Scheduler activity
You can interact with your Advanced Job Scheduler activity from a wireless device. Each activity
has different options based on the status of the activity entry.
Internationalization
Advanced Job Scheduler for Wireless uses the country and language codes associated with your
System i (TM) Java(TM) Virtual Machine to determine what language and date/time formatting to
use on your wireless devices. If the Java Virtual Machine defaults are not the codes you want to
use, you can easily change it. See the online help for more details.
See the online help for more details about performing specific tasks.

Troubleshooting the Advanced Job Scheduler
When a job does not run at the scheduled time, these troubleshooting methods can help you find out
what you can do.
To troubleshoot the Advanced Job Scheduler, first view the Frequently Asked Questions page at Job
Web site. See the commonly asked questions that identify how to do certain
Scheduler for i5/OS
functions with Advanced Job Scheduler.
Also, here are a list of items that you can review when a job does not run at the scheduled time:
Current fix level
The first thing you should verify is that your fixes are current. When you request fixes, be sure to
request a list of all fixes. Not all fixes are included in the Cumulative PTF packages.
Check job monitor
v Job QIJSSCD should be active in the QSYSWRK subsystem. If it is not, process the Start Job
Scheduler (STRJS) command.
v The job monitor can be in a loop if the status of the job is RUN for over ten minutes. If it is in
a loop, end the job with *IMMED, and start the job monitor again (STRJS).
v If there is a message to answer, reply with a C (Cancel). The job monitor goes into a 90-second
delay and then start monitoring again. Print the job log for the monitor job. This contains the
error messages.
Check the Advanced Job Scheduler log
Process the Display Log for Job Scheduler (DSPLOGJS) command for the job. Press F18 to go to
the end of the list. Entries exist to explain why the job did not run. Examples of the entries
include a resource failure, active or job dependency situation, or submission error.
Dependency on another job
If the job is dependent on another job, take option 10 from the Work with Jobs display to display
job dependencies. Press F8 to list all predecessor jobs. A dependent job cannot run unless all the
predecessor jobs show *YES in the Complete column.
Track a job's progress
If a job is not functioning properly, you can use the Set Step using Job Scheduler (SETSTPJS)
command before or after a step in your CL program to help determine what the problem is.
Specify the command along with description text in your CL program. Use this command as
many times as necessary. The text description that is associated with the current command is
displayed in the Command step field on the Last Run page of the scheduled job properties. In
addition, you can view the Command step field on the Status window of an active job. The
Command step field is automatically updated every time the job encounters the SETSTPJS
command. Use this command to help determine the progress of a job.
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Collecting these data samples can help in your problem analysis:
Error message conditions
Print the job log for the interactive session, monitor job or scheduled job, depending where the
error occurred.
Job schedule date is not correct
Process the DSPJOBJS command for the job with OUTPUT(*PRINT). Print a calendar report if a
calendar is used within the job. Print a holiday calendar report if a holiday calendar is used
within the job. Press the Print key to print the display of each fiscal calendar entry for the fiscal
calendar used within the job.
Advanced Job Scheduler log
Always print the Advanced Job Scheduler log for the time period in question.
Files QAIJSMST and QAIJSHST
Files QAIJSMST and QAIJSHST in library QUSRIJS might need to be journaled before trying to
reproduce the problem. Also, the QUSRIJS library may be needed by IBM support.

Advanced Job Scheduler
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Appendix. Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.
IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:
IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan
The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.
This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
IBM Corporation
© Copyright IBM Corp. 1998, 2008

27

Software Interoperability Coordinator, Department YBWA
3605 Highway 52 N
Rochester, MN 55901
U.S.A.
Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.
The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.
Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.
All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.
This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.
Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:
© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_. All rights reserved.
If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks
The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:
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i5/OS
IBM
IBM(logo)
System i
Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks
of Adobe Systems Incorporated in the United States, and/or other countries.
Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.
Other company, product, and service names may be trademarks or service marks of others.

Terms and conditions
Permissions for the use of these publications is granted subject to the following terms and conditions.
Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.
Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.
Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.
IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.
You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.
IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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